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Selecting An Effect

To create a transitional effect using TransJammer, you can start either by picking your pictures or by 
picking the effect you'd like to perform. 

You can do either of these steps first. 

In fact, you're free to change your mind about the pictures you'll use or which effect you've picked right 
up to the point where you tell TransJammer to Go!

Under the heading, "Available Effects," there is a scrollable list of the TransJammer effects found in the 
currently Selected Effects Directory.

You can select from one of the listed effects by:
clicking the primary mouse button on the effect's name.
scrolling upward or downward with the up and down cursor keys on your keyboard.

As soon as you've selected any effect, TransJammer sets about the task of reading in that effect's 
description and sample animation. You're free to move on and select another effect at any time. You 
don't have to wait for TransJammer to finish reading the effect's sample animation to move on to another
effect selection, or even to another part of the program.

What's Included In An Effect's Description?

Elastic Reality, Inc. has established the following conventions for the minimum amount of information 
which should be found in every effect's description. 

Note: An effect's description is text stored directly within TransJammer effect files. This text can be 
edited by anyone using a simple text editor, or by anyone who also owns Elastic Reality, so 
there is no guarantee that a specific effect's description will conform to the conventions that 
Elastic Reality, Inc. has defined.

At a minimum, each effect's description should contain:

Full Name: <a more descriptive name than DOS 8.3 file names allow>
Author: <the name of the person or company who created this effect>

<a full prose description of what happens during the effect>

Flip Horizontal: <a description of what effect turning on Flip Horizontal would have>

Flip Vertical: <a description of what effect turning on Flip Vertical would have>

Reverse: <a description of what effect turning on Reverse Effect would have>

What Does The Sample Show?

As mentioned before, as soon as you select an effect, TransJammer sets about reading in the effect's 
description and sample animation.

A sample animation is optionally stored directly within a TransJammer effect file. If the selected effect 
doesn't contain a sample animation, the "Sample" box in the TransJammer window will remain dark.

All TransJammer effects supplied directly by Elastic Reality, Inc. will contain sample animations. Owners 
of the Elastic Reality special effects creation program have the ability to create and embed their own 
sample animations in    TransJammer effects files, including the ability to replace our sample animation in



Elastic Reality, Inc. provided effects files.

The sample animation shows 8 evenly spaced frames from the full effect. This number of frames is 
chosen as a compromise. On the one hand, more frames in the sample yields a more accurate "picture" 
of what the effect is doing. On the other hand, the sample animation is stored directly in the effect's file. 
More frames in the sample animation would make the effects files too large for comfort.

Usually, 8 frames is adequate to convey an idea of what the effect is doing. 

In some cases, especially when there's complex motion in the effect, 8 frames simply aren't enough to 
accurately convey what the effect is aiming to do. In these cases, combining the information contained in
the effect's prose description with the sample animation should be enough to provide you with a clear 
prediction of what the effect is going to do.

Note: The sample animation does not reflect any Variations you might choose to employ. That's why 
each effect's prose description should include a description of what will happen with each 
Variation.

See Also: Selecting A Variation, Flip Vertical, Flip Horizontal, and Reverse Effect



Overview

TransJammer, from Elastic Reality, Inc., makes creating cool transition effects between still and moving 
images quick and easy. Simply pick an effect, pick your images, tell it how many images to create, and 
tell it to go!

TransJammer effects can spice up any video or multimedia presentation created for home or office use. 

Because of TransJammer's high quality and resolution independence, you can use it to create 
transitional effects for television and even film productions.

All TransJammer effects are fully anti-aliased to give smooth edges and seamless composites. 

And, you can make TransJammer effects of any length since it automatically scales all movements to 
correctly fill the length of time you've specified..

TransJammer is also unique in that it is the only transitional effects generator that allows you design new
transitional effects from the ground up without you having to be a programmer. 

With the additional purchase of the Elastic Reality shape-to-shape warping and morphing package, you 
can create new TransJammer effects or modify existing ones, just by moving shapes around on-screen.

Written as a Windows NTTM 32 bit application under the Win32s API, TransJammer delivers true 32 bit 
performance, real multitasking and multi-threading under WindowsTM, Windows for WorkgroupsTM, and 
Windows NT.

While TransJammer is designed to run on any 386, 486, or Pentium(TM) system, with four megabytes or
more of memory, your best results will be had from systems with floating point hardware support (like the
Intel 80387 math co-processor, the Intel 486DX, and the Pentium). 

Thank you for purchasing Elastic Reality's TransJammer.

Let the effects begin!



Multitasking?

Multitasking is the ability of a computer to seem to actively execute more than one program at the same 
time.

TransJammer has been carefully designed to multitask efficiently and effectively. If you've got a system 
with sufficient main memory, you'll find that even when TransJammer is rendering effects (a process akin
to flying a jet in a good flight simulator), your system will be responsive and you'll be able to use other 
programs productively.

Note that other programs which have not been designed to multitask as efficiently as TransJammer can 
prevent TransJammer from running. TransJammer, on the other hand, will almost never prevent the 
running of other programs.



Multi-Threading?

Multi-Threading is multitasking within a single program. TransJammer makes extensive use of multi-
threading to make using it more efficient.

Examples of multi-threading in TransJammer include the selection and reading of effects files. 
TransJammer busies itself reading in an effect's postage stamp sized sample animation in a separate 
thread allowing you to continue scrolling through the list of effects, or even click on the "Select Pictures" 
button (all while the animation is still being read in).



Select Effect Directory

TransJammer effects files have the same file extension as Elastic Reality project files (because that's 
what, in fact, TransJammer effect are: Elastic Reality projects). 

If you also own Elastic Reality, we strongly suggest that you keep Elastic Reality project files in a 
different directory than TransJammer effects files so that the "Available Effects" list in TransJammer 
contains nothing but honest-to-goodness TransJammer effects.

If you've stored TransJammer effects in a directory of your own, you can navigate there by clicking the 
button marked "Select Effects Directory." Doing so brings up a standard Windows directory selection 
dialog.



Terminology

While TransJammer really is an very simply program to operate, there are a few terms that you need to 
know to help you read and understand this on-line help (and the program itself). 

These are:
A Roll
B Roll
Background Roll
Frame



Terminology - A Roll

The A roll is the picture or sequence of pictures you're transitioning from. 

That is, the A roll is the picture or sequence of pictures that you want to be showing immediately before 
the transition (to the B roll) starts to happen.

See Also: B Roll, Frame, Background Roll



Terminology - B Roll

The B roll is the picture or sequence of pictures you're transitioning to. 

That is, the B roll is the picture or sequence of pictures that you want to be showing immediately after 
the transition (from the A roll) is finished happening.

See Also: A Roll, Frame, Background Roll



Terminology - Frame

A "frame" is a single image from either the A roll, B roll, Background roll or the output of TransJammer.

See Also: A Roll, B Roll, Background Roll



Selecting A Variation

There are three variations that you can combine together to create as many as 8 related effects from 
one TransJammer effects file. These are: Flip Vertical, Flip Horizontal and Reverse Effect.

You turn a variation on and off by clicking the primary mouse button in or close to the check box for the 
desired variation. There's also keyboard accelerators to turn variations on and off.

A variation is "on" when its associated check box is checked.

Note: The sample animation does not reflect any variations you might choose to employ. That's why 
each effect's prose description should include a description of what will happen with each 
variation.

See Also: Selecting An Effect, Flip Vertical, Flip Horizontal, and Reverse Effect



Keyboard Accelerator?

A keyboard accelerator is a keystroke or sequence of keystrokes that is equivalent to some action using 
the mouse such as choosing a menu item, clicking a button, clicking in a check box, etc.



Flip Vertical

When the checkbox for Flip Vertical is checked, the effect's sense of up and down are reversed.

Specifically, the effect is flipped about an imaginary horizontal line through the middle of your    images.

So, for example, if a piece of the A roll flies off the top of the screen when Flip Vertical is not checked, it 
will fly off the bottom of the screen when Flip Vertical is checked.

Keyboard: ALT+v

See Also: Selecting A Variation, Flip Horizontal, and Reverse Effect



Flip Horizontal

When the checkbox for Flip Horizontal    is checked, the effect's sense of left and right are reversed.

Specifically, the effect is flipped about an imaginary vertical line through the middle of your    images.

So, for example, if a piece of the A roll flies off the left side of the screen when Flip Horizontal is not 
checked, it will fly off the right side of the screen when Flip Horizontal    is checked.

Keyboard: ALT+f

See Also: Selecting A Variation, Flip Vertical, and Reverse Effect



Reverse Effect

When the checkbox for Reverse Effect    is checked, the effect is inverted by internally swapping the A 
roll and B roll and playing the effect backwards.

It is important for you to remember that even though Reverse Effect internally swaps the A and B rolls, 
the A roll is still the sequence of images you're starting with...and the B roll is still the sequence of 
images you'll end with.

For example, take an effect which, when played without Reverse Effect checked, starts with the A roll. 
The A roll tips over and falls forward to reveal the B roll.

When Reverse Effect is checked, you'll still start with the A roll. But instead of the A roll tipping forward to
reveal the B roll, the B roll will rise up from below screen to cover up the A roll.

Keyboard: ALT+r

See Also: Selecting A Variation, Flip Vertical, and Flip Horizontal



Selecting Images

To create a transitional effect using TransJammer, you can start either by picking your pictures or by 
picking the effect you'd like to perform. 

You can do either of these steps first. 

In fact, you're free to change your mind about the pictures you'll use or which effect you've picked right 
up to the point where you tell TransJammer to Go!

Clicking the primary mouse button on the button marked "Select Images..." (or pressing ALT+i on your 
keyboard) brings up a dialog called the Sequence Editor.

The Sequence Editor contains a few menus and up to three rows where you can insert frames. The 
three rows correspond to the A roll, B roll, and the Background roll.

Most TransJammer effects require images to be added to only the A roll and the B roll. A few 
TransJammer effects are designed to optionally accept a Background roll as well.

Adding Images To A Roll

Click in the roll into which you'd like to add a picture. Then, press the INS key on your keyboard or 
choose the Insert command from the Image menu. Select the files you wish to add using the file dialog 
which appears.

You'll note that the file dialog doesn't require for enforce the use of file name extensions. This is because
TransJammer, being a HIIP enabled application, can automatically detect what image file format a given 
file is written in without the aide of a specific file name extension.

You can also add images to TransJammer using Drag and Drop from the Windows File Manager. Simply
drag the file names of the images you wish to add from the File Manager to the roll you wish to add them
to.

How Many Images Should I Add?

If you'd like to create a transitional effect between two still images, simply place the "before" image in the
A roll and the "after" image in the B roll. That's it.

If you'd like to create a transitional effect between two moving sets of images, place each image from 
the "before" series in the A roll and each image from the "after" series in the B roll. 

Note: TransJammer's purpose is to create transitional effects. It is intended to augment, not replace, 
other multimedia integration programs such as Adobe Premiere and In:Sync's Razor.

So, if you'd like to show a bunch of the A roll and then do a transition and then show a bunch of 
the B roll, only add the portion of the A and B rolls which overlap (and would be where the 
transition occurs) into TransJammer.    What happens before the transition starts, or after the 
transition ends, is beyond the scope of TransJammer.

What's All These Black Boxes?

When you add an image to the Sequence Editor, TransJammer will attempt to load a corresponding 
postage stamp sized image. If a corresponding stamp isn't available, the Sequence Editor displays a 
black box representing the frame.

To make stamps, select the frames you wish to make stamps for and press CTRL+M or choose the 



"Make Stamps" command from the Image menu.

How Do I Get Out Of The Sequence Editor?

To exit the Sequence Editor and have it remember any changes you've made, choose the "Accept" 
command from the File menu. 

To exit the Sequence Editor and lose any changes you might have made, press the ESC key or choose 
the "Cancel" command from the File menu.



Terminology - Background Roll

The Background roll is an occasionally used third set of pictures which appears behind both the A roll 
and B roll in some TransJammer transitions.

When a transition is designed that has both the A roll and B roll moving around in it, the effect designer 
may elect to allow for a third, or Background, roll. 

If an effect can make use of a Background roll, the comment "Background roll is allowed" will be 
highlighted in the TransJammer user interface. If you don't specify any pictures in the Background roll, 
black will be used.

See Also: A Roll, B Roll, Frame



Defining Output Options

After you've picked an effect and picked pictures on which to perform the effect, you can set output 
options. These include:

Setting Output Size
Setting Duration, Start and End Frames
Selecting The Output File Type
Selecting An Output Directory
Setting A File Name Template

Setting Additional Image Save Options
Setting Color Reduction Options



Notices

Program and documentation are Copyright (c) 1993-1994 Elastic Reality, Inc. All rights are reserved.
 
TransJammer, HIIP, Host Independent Imaging Protocol, Elastic Reality,    the Elastic Reality, Inc. Logo 
and the Elastic Reality Logo are trademarks or registered trademarks of Elastic Reality,    Inc. Other 
trademarks or registered trademarks are the property of their respective holders.

No part of this program or its documentation, electronic or otherwise, may be duplicated using any 
means except those explicitly authorized in your licensing agreement. 

USE OF THIS SOFTWARE IS SUBJECT TO THE TERMS OF A LICENSING AGREEMENT BETWEEN 
YOU AND ELASTIC REALITY, INC.

IN ACCORDANCE WITH THE COMPUTER SOFTWARE RENTAL
ACT OF 1990, THIS SOFTWARE MAY NOT BE RENTED, LENT, OR

LEASED



Setting Output Size

You can set the width and height of the images to be output by TransJammer by entering the values you 
wish into the Width and Height fields of the Output Options dialog.

If you enter a value of 0 in the Width field, both the Width and Height will be reset back to the width and 
height of the first image in the A roll.

When you make a change to the Width, a corresponding change is automatically made to the Height. 
For example, if you halve the Width, the Height is also halved. You can override this by adjusting the 
Height.

The images you've selected will be scaled to whatever size you specify in the Width and Height fields.

Note: Execution time and memory requirements are directly tied to Width and Height. The larger these
values, the longer an effect will take to render and the greater the memory it will require.

See Also: Setting Duration, Start and End Frames, Selecting The Output File Type, Selecting An 
Output Directory, Setting A File Name Template



Setting Duration, Start and End Frames

If you're creating a transition between two still images, you can set the Duration field to however long 
you want the transition to last. 

However, if you're creating a transition between two sets of moving images, the number of images 
you've specified in the Sequence Editor determines the Duration. 

The Start and End fields can be set to any value between 1 and the value in Duration as long as the End
value is at least as large as the Start value.

Typically the value in the Step field is set to 1. This means each frame between Start and End will be 
created. If you'd like to create every other frame, for example, enter a value of 2 in this field. Every third 
frame requires a value of 3, and so on.

See Also: Setting Output Size, Selecting The Output File Type, Selecting An Output Directory, 
Setting A File Name Template



Selecting The Output File Type

Below the controls for setting width, height, start, end, and duration, are three controls pertaining to 
output file type.

If you click in the file type combo box, a list of the supported file types will be displayed. Choose the file 
format you desire from this list.

If the chosen file type supports any user definable parameters (such as JPEG and Video for Windows, 
for example), the button marked "Parameters" becomes accessible. 

Clicking on the button marked "Saver Info" shows information about the capabilities of the chosen output
format.

See Also: Setting Output Size, Setting Duration, Start and End Frames, Selecting An Output 
Directory, Setting A File Name Template



Selecting An Output Directory

Clicking on the button marked "Directory..." displays a file dialog in which you should navigate to the 
directory where you want the output of TransJammer to be written.

You can also enter the path directly into the string control to the right of the button marked "Directory...".

See Also: Setting Output Size, Setting Duration, Start and End Frames, Select Output File Type, 
Setting A File Name Template



Setting A File Name Template

TransJammer has a very flexible template-based scheme for naming its output files.

Three checkboxes control the inclusion of three variables, for which letters and numbers are 
automatically substituted to build a final output file name.

These are:

Use Source File Name checkbox

If this checkbox is checked, a variable denoted by the letters "[base]" appears in the File Name 
Template. "[base]" is replaced by the effect name (or a prefix of the effect name to make the full file 
name fit in the DOS 8.3 file name limit).

If this checkbox is not checked, the letters "unnamed" appear in the File Name Template. If you replace 
these letters with letters of your own choosing, your choice will be used to create the output file names.

Add Frame Number checkbox

If this checkbox is checked, a variable denoted by the letters "[num]" appears in the File Name Template.
"[num]" is replaced by an automatically generated output frame number. See below for more information 
about specifying how to generate the output frame numbers.

If this checkbox is not checked, no automatically generated frame numbers will be part of the resulting 
file names. This means that each file output by TransJammer will have the same name. 

If the Output File Type is an animation format like Video for Windows, this is appropriate. It would mean 
that each output frame is appended to the animation file being written.

If the Output File Type isn't an animation format, then each frame that TransJammer writes will overwrite
the previous frame since all of the output file names are the same. 

TransJammer will warn you of this possibility if the Add Frame Number checkbox is not checked when 
you click the OK button.

Replace Extension checkbox

If this checkbox is checked, a variable denoted by the letters "[ext]" appears in the File Name Template. 
"[ext]" is replaced by value of the Extension field. 
TransJammer knows the default file name extension for each of the image file formats that it supports. It 
fills in the Extension field with this value when you make an Output File Type selection.

If you'd like to override this default, simply enter the file name extension you wish in the Extension field 
and make sure the Replace Extension checkbox is checked. 

If the Replace Extension checkbox is not checked, no file name extension will be added unless you 
explicitly typed it into the File Name Template field.

Note: While TransJammer and other Elastic Reality, Inc. applications don't rely upon file name 
extensions to determine image file format, other applications for Windows (and other systems) 
are not as advanced.

Therefore, do use the appropriate file name extension when possible to ensure the widest 
possible portability of your image files.



Specifying How To Generate Frame Numbers

When the Add Frame Number checkbox is checked, TransJammer automatically generates frame 
numbers to become part of output file names.

The number of digits (filled with leading zeros) is determined by the value you place in the Number Of 
Digits field.

TransJammer will start counting frame numbers beginning with the value you specify in the Initial Frame 
Num field. 

So for example, if you wished to output files with frame numbers which have no leading zeros    and 
begin counting at 56, you'd enter a value of 56 into the Initial Frame Num field and a value of 1 into the 
Number of digits field. 

File Name Template and Sample Name

The ultimate decision maker as to how TransJammer creates output file names is the string appearing in
the File Name Template field. You can use the variable substitution checkboxes described above to 
assist you with coming up with the template that meets your desires. 

Or, you can edit the string in the File Name Template field directly, if you wish.

Whatever you do, TransJammer always gives you an idea of what the resulting file names will look like 
by printing a "Sample Name".

See Also: Setting Output Size, Setting Duration, Start and End Frames, Select Output File Type, 
Selecting An Output Directory



Go!

When you've picked an effect and selected your images, the Output Options button becomes 
accessible. 

When you've picked some Output Options, the Go! button becomes accessible. 

And when you click that, the effect will be generated.

TransJammer starts rendering the effect you picked according to the specifications you've defined.

TransJammer renders wonderfully well in the background. Feel free to make use of Windows' 
multitasking capabilities while TransJammer makes use of whatever spare machine cycles your other 
applications don't gobble up.



Creating Your Own TransJammer Effects

TransJammer is a completely open and extensible system. 

If you'd like to create your own TransJammer effects, you can do so by purchasing Elastic Reality for 
Windows at your favorite retailer or direct from Elastic Reality, Inc.

With Elastic Reality for Windows, you directly manipulate the shapes that move around the screen to 
create the desired effect. To make a tile tumble downwards, for example, you draw a box and drag it 
downwards. Elastic Reality even has a real time wire frame preview mode that lets you preview your full 
effect without waiting for any frames to render.

Elastic Reality isn't just for creating TransJammer effects. 

It's the world's most advanced commercially available warping, morphing and special effects system and
is responsible for most of the coolest morphing and warping effects you've seen on Television and in the 
Movies.

Elastic Reality's incredible power and ease-of-use make it flexible enough to be used as the nucleus for 
TransJammer, and for many other applications beyond warping and morphing. These include powerful 
applications in cel- and stop-motion animation, and full motion compositing.

Check out Elastic Reality today!



The Comments And Recommendations Area

Depending upon the effect you select, and how you add images to the Sequence Editor, one or more of 
the three comments and Recommendations may be highlighted.

Here's what they mean:

This is a one roll effect

Remember when we said that TransJammer's purpose is to create transitional effects between an A roll 
and a B roll?

While that is true, we made TransJammer capable of making use of Elastic Reality "warping" projects as
well as transition style effects.

If you've selected an effect which is designed to distort a single roll, the comment "This is a one roll 
effect" will be highlighted. It means that you should specify only one roll (the A roll) in the Sequence 
Editor.

Two rolls required

This comment should be highlighted on nearly every TransJammer project since two rolls are required to
create a transition effect.

Background roll is allowed

Some TransJammer effects have been designed as 3 roll effects. They create a transition between the A
roll and B roll in such a way as to expose some background areas temporarily. 

If you've selected an effect of this sort (diagflip is an example) you can specify images to be used for the
background by adding them to the Background roll in the Sequence Editor.



Setting Color Reduction Options

If the file format you've selected supports writing indexed color files, these controls determine how the 
full color imagery processed by TransJammer will be turned into a low color rendition. 

These controls are not accessible if the selected format cannot output indexed color images.

An example of a format which supports both true color and indexed color is the BMP format.

An example of a format which supports only index color is the GIF format.

An example of a format which supports only true color is the SGI RGB format.

If the selected format supports both indexed and true color output, you can choose either 24 for true 
color or 8 for indexed color from the Depth field.

If you choose 24, the other choices become inaccessible.

Note: When outputting AVI files, you may want to keep the color depth set to 24 and let the CODEC 
used by Video For Windows determine how best to reduce the color information if necessary.

However, TransJammer does support directly writing index color AVI files.

Dithering is a technique which enables an image to give the impression of more colors than it actually 
contains. It does this by using groups of pixels in combination to produce the appearance of colors 
which are actually not present in the image's palette.

TransJammer supports four dithers. 

These are:

None No dithering will take place. Color banding is likely except in cases of primarily 
monochromatic images.

Ordered Faster An ordered dither which produces good results for animation purposes.

Ordered Better An ordered dither with higher quality (at the expense of slightly slower execution) which 
produces good results for animation purposes.

Floyd An error diffusion dither which produces good results for still imagery but may introduce 
visible artifacts when used in animations.

To reduce a true color image down to relatively few colors, a color picking step must be performed. The 
aim of this step is to choose a small palette which is visually representative of the colors contained in the
true color image.

TransJammer currently provides 3 methods for color picking. 

These are:

Fixed One of two fixed palettes will be used depending upon the state of the "Preserve 
Windows Palette" checkbox. This setting provides the highest performance since no 
actual color picking computations are performed.

Octree This method of color picking performs best when the source true color imagery contains 
relatively few colors. Computer generated images, for example, and close-ups of faces.



Median This method of color picking performs best when the source true color imagery contains 
a huge number of colors. Scans of natural images like landscapes, for example.

After deciding how the colors will be picked, you must determine where the colors that are used to do 
the picking will come from.

This is determined in the "Get palette from" area. 

If you click "First Frame," TransJammer will build its computed palette based upon the first frame of 
output. If the colors present in the first frame are radically different from the colors present in the last 
frame, the ending frames will suffer. If this is the case, you might want to use one of the Fixed palettes 
which give satisfactory results in general. 

If you click "Every Frame," TransJammer will build an optimal palette for each and every frame. This will 
consume extra time during rendering but always picks the best colors for each image.

Note: If you're writing AVI files, be aware that most AVI players, including the standard ones provided 
by Microsoft, do not support palette changes per frame. Therefore, clicking "Every Frame" will 
produce AVI files which cannot be properly played by most players. This capability is provided 
with an eye towards the future when this capability will be more widely supported.



The pixel values in the file are used as an index into a table of prepared color values. 

Since relatively few colors can be held in the prepared table, a palette choosing step must be performed.

And, since many colors will not be found in the resulting table (due to its small capacity, generally 256 
colors), a technique called    dithering can be employed to give the impression of more colors.



Additional Image Saving Options

This area of the Output Options dialog contains four checkboxes which allow you to set some additional 
image saving options:

Save Effect

This item is usually checked since it informs TransJammer that you'd like to save the finished results of 
each frame's computation. 

If you uncheck this box, TransJammer will perform its full computation but the final results will not be 
saved.

You might uncheck this box if you're only interested in saving one of the intermediate stages (such as 
the warped A or B rolls as described below).

Save Warped A Roll

If this box is checked, the intermediate results of the A roll warp will be saved with the same name, path, 
and parameters as specified in your output file name template with the exception that an "a" will be 
prepended to the output file name.

This feature is useful if you wish to preserve the intermediate steps of a morph so that the rolls can be 
composited elsewhere.

Save Warped B Roll

This checkbox is accessible only when you're working on a morph document (ie: a document with both 
an A and B roll).

If this box is checked, the intermediate results of the B roll warp will be saved with the same name, path,
and parameters as specified in your output file name template with the exception that a "b" will be 
prepended to the output file name.

This feature is useful if you wish to preserve the intermediate steps of a morph so that the rolls can be 
composited elsewhere.



Using TransJammer To Build And Bust AVI Files Or As A Format/Size Converter

The TransJammer effect "passthru.er" can be used to turn TransJammer into a handy tool for building 
and busting AVI files, as well as for batch oriented image file format conversion and size changing.

To Build An AVI File From Single Images...

Place all of the single images you wish to merge into an AVI file in the A roll. Use the Sequence Editor's 
cut and paste commands if you need to reorder the images into a desired sequence.

Click on the "passthru.er" effect, and specify output options appropriate for making an AVI file.

Click Go!

Each of the images in the A roll will be read and, in turn, written to the AVI file you've specified.

To Bust An AVI File Into Single Images...

Insert the AVI file into the A roll. Use the Sequence Editor's Make Stamp command to see portions of the
AVI file, if necessary to aide you in clipping out unwanted portions using the cut command. 

Click on the "passthru.er" effect, and specify the output options you desire.

Click Go!

Each frame of the AVI file which was specified in the A roll (remember, you can include a portion of an 
AVI file in the A roll) is read in and converted to a single image file according to the output specifications 
you made.

To Batch Convert Image File Formats and Sizes

Place the images you wish to convert into the A roll.

Specify the output options you desire.

Click Go!

Each file in the A roll is read in, and then written according to the output specifications you made.




